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Test Bank - Chapter 2

Gaining Proficiency: Editing and Formatting
Multiple Choice
1.
Which of the following commands will affect the contents of the clipboard?

(a) Copy

(b) Paste

(c) Both Copy and Paste

(d) Neither Copy nor Paste

answer: a

2.
What happens if you select a block of text, copy it, move to the beginning of the document, paste it, move to the end of the document, and then click paste again?

(a) The selected text will be inserted only at the beginning of the document

(b) The selected text will be inserted at the beginning and end of the document 

(c) The selected text will be deleted from the document

(d) The situation is not possible; that is, you cannot paste twice in a row without an intervening cut or copy operation

answer: b

3.
Suppose you select and copy a section of text, then paste it in another location, then change your mind about having the passage appear twice and cut the first occurrence out of the document. Which of these operations placed text onto the clipboard?

(a) Cut and Copy

(b) Paste only

(c) Cut only

(d) Copy only

answer: a

4. Which of the following are set using the Format Paragraph command?

(a) Line spacing and alignment

(b) Borders and shading

(c) Tabs and indents

(d) All of the above

answer: d

5.
Suppose you have just typed a sentence in Arial 10 point font, and realize you wanted it in Century Schoolbook 12 point. What is the best way to change the font of the sentence?

(a) Select the text, then choose the new font, then retype the text

(b) Select the text, then choose the new font

(c) Choose the new font then select the text

(d) It is not possible to change the font of existing text

answer: b

6.
Which of the following cannot be changed using the Page Setup command?

(a) The margins in a document

(b) The line spacing in a document

(c) The orientation of a document

(d) All of the above can be changed using the Page Setup command

answer: b

7.
Suppose you want to change the indents in a document. Which command would you use?

(a) Insert Break

(b) File Page Setup

(c) Format Paragraph

(d) None of the above

answer: c

8.
The spacing in an existing multi-page document is changed from single spacing to double spacing throughout the document. Which of the following statements about soft page breaks before and after the formatting change is true?

(a) The number of soft page breaks is the same but their location is different

(b) The number and position of soft page breaks is different

(c) The number and position of soft page breaks is the same

(d) It is not possible to determine the answer from the information given

answer: b

9.
Assume you are working on a Word document. What happens if you point anywhere in the document and click the right mouse button?

(a) A shortcut menu appears that is appropriate to the item you have selected

(b) The word you pointed at is selected

(c) You will hear a beep because you tried to perform an invalid operation

(d) Nothing

answer: a

10.
Which of the following fonts is sans serif?

(a) Arial

(b) Times Roman

(c) Both Arial and Times Roman

(d) Neither Arial nor Times Roman

answer: a

11.
You are planning to use the Replace command. Which of the following statements is true?

(a) The find and replace strings must be the same length

(b) The find and replace strings must be the same case, either upper or lower

(c) The find and replace strings must be both the same length and the same case

(d) The find and replace strings may be of different lengths and cases

answer: d

12.
Which of the following actions will move the insertion point to the top of the document?

(a) Press Ctrl+Home

(b) Drag the scroll bar to the top of the scroll box

(c) Press Ctrl+PageUp

(d) None of the above

answer: a

13.
Which of the following substitutions can be accomplished by the Replace command?

(a) Text

(b) Formatting

(c) Both text and formatting

(d) Neither text nor formatting

answer: c

14.
Which of the following deselects a selected block of text?

(a) Clicking anywhere outside the selected text

(b) Pressing an arrow (cursor movement) key

(c) Pressing PageUp or PageDown

(d) All of the above

answer: d

15.
If you want to see the top and bottom margins of a document, which view should you be in?

(a) Page Layout view at 100% magnification 

(b) Page Layout view at Whole Page magnification

(c) Normal view at Whole Page magnification

(d) Full Screen view

answer: b

16.
Which of the following cannot be set using the Format command?

(a) Line spacing

(b) Margins

(c) Tabs and indents

(d) Alignment

answer: b

17.
How do you bring up a shortcut menu when working in Word?

(a) Press Ctrl+Home

(b) Click the right mouse button

(c) Click the left mouse button

(d) Double click the right mouse button

answer: b

18.
Suppose you have selected the last sentence in a paragraph of text. Which of the following will not deselect the sentence?

(a) Dragging the scroll box upward in the vertical scroll bar

(b) Pressing an arrow (cursor movement) key

(c) Pressing PageUp or PageDown

(d) Clicking anywhere outside the selected text

answer: a

19.
The Undo command is available:

(a) On the Standard toolbar

(b) On the Edit menu

(c) On both the Standard toolbar and the Edit menu

(d) On the Formatting toolbar

answer: c

20.
Which of the following commands also incorporates the Find command?

(a) Undo

(b) Redo

(c) Replace

(d) All of the above

answer: c

21.
You are using the Replace command to replace all occurrences of the word his with his/her. You have not selected any options in the Replace dialog box. Which of the following words would be selected during the selective replacement operation?

(a) History

(b) His

(c) Both His and History

(d) Neither His nor History

answer: c

22.
Which of the following describes the effects of the Zoom command?

(a) It affects the size of the displayed document

(b) It affects the size of the printed document

(c) It affects the size of both the displayed and the printed document

(d) It affects the size of the buttons on the toolbars only

answer: a

23.
Which of the following Zoom options cannot be set from the Standard toolbar?

(a) Page Width

(b) Whole Page

(c) Two Pages

(d) Many Pages (more than two)

answer: d

24.
Which of the following Zoom options automatically adjusts the printed page size?

(a) Page Width

(b) Whole Page

(c) Many Pages

(d) None of the above

answer: d

25.
Which Word command allows you to see multiple pages at one time on the screen?

(a) Page Setup

(b) Zoom

(c) Format

(d) All of the above

answer: b

26.
Assume you are typing a Word document and want to change the magnification on the screen. How can you do this?

(a) Use the Zoom command on the View menu

(b) Use the Zoom magnification button on the Standard toolbar

(c) Using either the View menu or the Standard toolbar

(d) It is not possible to change the display magnification

answer: c

27.
Which of the following key combinations is a shortcut for the Copy command?

(a) Ctrl+C

(b) Ctrl+X

(c) Ctrl+Z

(d) Ctrl+Del

answer: a

28.
Suppose you select text in a document and then press Ctrl+C. What happens?

(a) The selection is cut from the location and copied to the clipboard

(b) The selection remains in place and is copied to the clipboard

(c) The contents of the clipboard replace the selected text

(d) Nothing; the key combination is invalid

answer: b

29.
Which of the following key combinations will affect the contents of the clipboard?

(a) Ctrl+C

(b) Ctrl+X

(c) Both Ctrl+C and Ctrl+X

(d) Neither Ctrl+C nor Ctrl+X

answer: c

30.
Which of the following key combinations will affect the contents of the clipboard?

(a) Ctrl+V

(b) Ctrl+X

(c) Both Ctrl+X and Ctrl+V

(d) Neither Ctrl+X nor Ctrl+V

answer: b

31.
You are typing a document and use the Cut command to remove a sentence from the first paragraph. Which of the following methods will return the sentence to the same place, assuming you have not moved the insertion point?

(a) Click on the Paste button

(b) Click on the Undo button

(c) Click on either the Paste button or the Undo button

(d) None of the above

answer: c

32.
Which type of font is considered more effective for small amounts of text such as is found in a heading or corporate logo?

(a) Serif

(b) Sans serif

(c) Either serif or sans serif

(d) Neither serif nor sans serif

answer: b

33.
Assume you are preparing a budget report which includes a set of numeric data that must be precisely lined up, one number beneath another. Which font would be best for this project?

(a) A serif font

(b) A proportional font

(c) A monospaced font

(d) None of the above; with today’s word processors, the characters cannot be lined up precisely

answer: c

34.
Assume you are creating a table in Word. It will have 10 columns and 20 rows, and will measure 10 inches wide by 6½ inches high. Which option would you select on the Paper Size tab in Page Setup?

(a) Portrait

(b) Landscape

(c) Either portrait or landscape

(d) Neither portrait nor landscape

answer: b

35.
Suppose you have entered a heading in your document in Arial 12 point bold italic. Which of the following will not be copied by the Format Painter?

(a) The text of the heading

(b) The font

(c) The bold formatting

(d) The italic formatting

answer: a

36.
All of the following alignment options have ragged margins except:

(a) Right align

(b) Left align

(c) Center align

(d) Justified

answer: d

37.
You are working on a term paper and want the text to line up flush with both the left and right margins. Which alignment option would you select?

(a) Right align

(b) Left align

(c) Justified

(d) Centered

answer: c

38.
Which of the following alignment options has both ragged left and ragged right margins?

(a) Centered

(b) Right align

(c) Left align

(d) Justified

answer: a

39.
A right tab with a dot leader is most useful for:

(a) The page number included in a header

(b) The page number in a table of contents

(c) A column of numerical data

(d) The first line indent in a paragraph

answer: b

40.
You are typing a report and want to print a long quote indented one inch from the left margin. Which key will move the entire quote to the right?

(a) The Tab key

(b) The Indent button on the Formatting toolbar

(c) Both the Tab key and the Indent button

(d) Neither the Tab key nor the Indent button

answer: b

41.
All of the following are set using the Format Paragraph command except:

(a) Line spacing

(b) Indents

(c) Margins

(d) Alignment

answer: c

42.
Which of the following is set using the Format Paragraph command?

(a) Margins

(b) Fonts

(c) Tabs

(d) None of the above

answer: d

43.
You are typing a document and notice that a soft page break has been inserted between a heading the succeeding paragraph. How can you prevent this?

(a) Select the Widow/Orphan Control check box on the Indents and Spacing tab

(b) Select the Keep Lines Together check box on the Indents and Spacing tab

(c) Select the Keep with Next check box on the Indents and Spacing tab

(d) Remove the soft page break

answer: c

44.
You are typing a term paper and notice that the first line of a paragraph appears alone at the bottom of page 3, with the rest of the paragraph at the top of page four. Likewise, the last line of a paragraph appears at the top of page 9, while the rest of the paragraph is at them bottom of page 8. Which of the following options on the Line and Page Breaks  in the Format Paragraph menu should be checked to avoid this problem throughout the document?

(a) Keep with Next

(b) Keep Lines Together

(c) Widow/Orphan Control

(d) All of the above

answer: c

45.
You copy a paragraph from one section of a paper to another, but notice that none of the formatting is copied with it. What is the most likely explanation?

(a) Formatting is not usually copied

(b) The paragraph mark (¶) at the end of the paragraph was not selected and copied with the paragraph

(c) The Format Painter was not turned on when the paragraph was copied

(d) This situation is not possible; formatting is always copied with the text

answer: b

46.
Where does the insertion point have to be located in order to apply a drop shadow border to a paragraph?

(a) In front of the first sentence in the paragraph

(b) At the end of the last sentence in the paragraph

(c) Anywhere in the paragraph

(d) It does not matter where the insertion point is, but the entire paragraph must be selected before applying the border

answer: c

47.
The Widows and Orphans command will affect:

(a) The location of soft page breaks

(b) The location of hard page breaks

(c) The location of both hard and soft page breaks

(d) Neither hard nor soft page breaks

answer: a

48.
What will happen if you press Ctrl+2 while typing a paragraph?

(a) The paragraph will be double spaced

(b) The insertion point will move up two lines

(c) The insertion point will move down two lines

(d) You will hear a beep as you have initiated an invalid action

answer: a

49.
Assume you are quoting a long passage in a term paper and want to indent it ½-inch from both margins. How can you do this?

(a) Using the Indents and Spacing tab in the Format Paragraph dialog box

(b) Using the ruler

(c) Using either the Indents and Spacing tab in the Format Paragraph dialog box or the ruler

(d) Using the Increase Indent button on the Formatting toolbar

answer: c

50.
Assume you are doing a budget report. Which type of tab stop would be best for any numeric data in the report?

(a) Left aligned

(b) Right aligned

(c) Centered

(d) Decimal alignment

answer: d

True/False

51.
Double clicking a word will select the entire paragraph.

answer: F

52.
Pressing the Ctrl key while clicking the left mouse button will select the sentence in which the insertion point is located.

answer: T

53.
The Cut, Copy, and Paste commands can only be accessed through the Edit menu or the Standard toolbar.

answer: F

54.
The Undo command must be executed before any intervening commands in order to reverse any command.

answer: F

55.
The replace string must be the same length and case as the search string in a Replace operation.

answer: F

56.
The insertion point does not move when scrolling through a document using the vertical scroll bar.

answer: T

57.
The insertion point moves in the document when the PageUp or PageDown keys are pressed.

answer: T

58.
Ctrl+V is the keyboard shortcut for the Paste command.

answer: T

59.
Times New Roman is a sans serif typeface.

answer: F

60.
Sans serif typefaces are effective for headlines and other small amounts of text.

answer: T

61.
TrueType fonts can be scaled to many difference sizes, and will appear on the screen in their true (WYSIWYG) size.

answer: T

62.
 A document set in a monospaced font with left justification will give a more professional appearance than one set in a proportional font with full justification.

answer: F

63.
You can use the Format Font command to change the color in which the text is displayed.

answer: T
64.
It is considered good design practice to use many different type faces and styles in a document, to increase the visual interest of the page layout.

answer: F

65.
Word inserts hard page breaks into a document to move the insertion point to the top of the next page.

answer: F

66.
Keep Lines Together will move an entire paragraph to the next page if it does not fit at the bottom of the preceding page.

answer: T

67.
Pressing F8 then the End key will select from the insertion point to the end of the line.

answer: T

68.
The Paste command does not effect the contents of the clipboard.

answer: T

69.
If you do not select Find Whole Words Only as an option in the Replace dialog box, the word this will be changed to thwas if the search and replace strings in an automatic replace operation are is and was, respectively.

answer: T

70
 You can see headers and footers in Normal view.

answer: F

71.
The Zoom command cannot be used in Normal view.

answer: F

72.
You can change the magnification of text on the screen using a button on the Standard toolbar.

answer: T

73.
Changing the magnification of text using the Zoom command changes the size of the printed text.

answer: F

74.
Ctrl+PageUp moves the insertion point to the beginning of the document.

answer: F

75.
It is possible to move text by dragging it with the mouse.

answer: T
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